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G7 System Certification 
Application Data Sheet 

 

 

 

The Idealliance Print Properties Committee has established a certification process for G7 
Calibration Systems. The G7 System Certification Program evaluates a candidate 
system’s ability to calibrate a printing device using only four 1-D Curves, according to 
the G7 formulae contained in ANSI CGATS TR015 and tolerances in this document.  
This Application Data Sheet (ADS) provides step-by-step instructions for evaluating the 
calibration accuracy of Curve4. For detailed instructions, see the Curve4 User Guide. 

 

Manufacturer 
Curve4 is a joint production of; 
 

HutchColor, LLC 
87 Brass Castle Rd 
Washington, NJ 07882 
908 689 7403 
www.hutchcolor.com 
 
and 
 
CHROMiX Inc 
9594 1st Ave NE #390 
Seattle, WA 98115 
206 985 6837 
www.chromix.com 

 
 
 
 
 
 
 
 
Certification Seal Here 
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Applicable Products 
Curve4 Calibrate (includes Verify module), and 
Curve4 Complete (includes Calibrate and Verify modules) 

G7 System Testing Methods 

Physical vs Modeling testing methods 
G7 Certified Systems can be tested either by measuring physical print samples 
(the “Physical Method”) or by analyzing correction curves in a mathematical 
model of a printing system (the “Modeling Method”). Results are compared to 
ideal measurements determined by the G7 formulae in ANSI CGATS TR015. 

A disadvantage of the Physical Method is that variations in the printing or 
measuring steps can reduce the reliability or accuracy of results. The Modeling 
Method eliminates these variations by extracting CIELAB data directly from 
the correction curves exported by the candidate system. 

Official G7 System testing 
The independent testing body (RIT) tests candidate G7 Systems by the 
Modeling Method, using commercially available software to convert CMYK 
calibration curve values to CIELAB, and a proprietary Microsoft Excel 
Workbook to perform the TR015 calculations. 

G7 Certified System vs. G7 Master Pass/Fail tolerances 
Note: G7 System Certification testing uses stricter tolerances than the G7 
Master Pass/Fail document: 
1. G7 Certified System testing does not use a weighting function, so shadow 

detail is tested more rigorously. 
2. G7 Certified System tolerances are 1.0 average and 2.0 maximum vs. 1.5 

and 3.0 respectively for G7 Master Pass/Fail. 

G7 Master Pass/Fail testing in Curve4 
Curve4 users can easily test G7 Master compliance with the Verify module 
and physical print samples. 

Curve4 Complete users can use the VPR tool (a Modeling system) to 
eliminate the possibility of printing or measuring errors on the second print. 

Step-by-step instructions for both Physical and Modeling Methods are given 
below. 
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Curve4 Testing Instructions – Physical Method 

Print the test target(s)  
Print at least one P2P51 target on the printing system to be calibrated. 

Note that to test a software’s ability to calibrate accurately, the printing system 
must produce successive prints that are consistent print-to-print and consistent 
across the whole image area. 
Ideally, all color management should be disabled and initial calibration curves 
should be “null” to produce a completely uncorrected print. 
Prints should be free from blemishes, streaks or other artifacts and have had 
sufficient time to dry or stabilize prior to measuring.  (See Curve4 User Guide 
for detailed target printing instructions.) 

Create a new Calibration 
In the Calibration panel, click New above the Calibrations list. 

In the Setup panel set the Method: to G7. 

In the Based On: list, select Linear (none). 

Measure the target(s) 
In the Runs list. click on Run 1 - Calibration. 

Under the Measurements list, click the Measure button and follow instructions 
to measure the target. To average more than one target, click Measure again 
and repeat the process. (Multiple targets are automatically averaged.) 

Adjust gray balance parameters 
In the Create Curves tab, click the Gray Balance Control tab and set the 
desired Gray correction feather-off: Start. For maximum accuracy on a stable 
and repeatable printing system, set the Start to 98. For printing systems with 
unstable shadow characteristics, select a lower Start value, like 75 or 50. 

Other controls 
For system certification purposes, leave all other controls at their default 
settings. (For real-world production calibration, the Curve4 User Guide 
suggests when and how to adjust other controls.) 

Choosing Control Points 
In the Control Points list, select the desired curve point values. On real 
printing devices, fewer points are generally safer, but for maximum theoretical 
accuracy and/or system certification purposes, select 25-step (P2P). 
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Applying Control Point values to the printing system 
If the RIP accepts digital files directly from Curve4, select the RIP name, click 
Export and import the resulting file into the RIP. (See Curve4 User Guide for 
detailed instructions.) Otherwise type the numbers in manually. 

Verifying G7 Grayscale Accuracy 

Print a “Verification” target 
Print one or more P2P targets again on the same printing system and 
conditions, but through the new RIP curves. 

Measure the Verification target 
Create a new Run. The default name will be Run 2 – Verification1. 

Click the Measure button and measure the new P2P target(s) as before. The 
data are automatically added to the Run. 

Checking Pass/Fail status 
Click the Analyze tab. 

To test G7 Grayscale accuracy, any Reference can be selected, or select a G7 
Grayscale reference, if available (see Curve4 User Guide). 

 
Figure 1: The Analyze G7 Master tab 
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If the wΔL* and wΔCh values under G7 Grayscale column are all green, your 
sample passes the current Idealliance G7 Master specifications. 

Curve4 Testing Instructions – Modeling Method 
NOTE:  Results determined by the Modeling Method may differ slightly from 
results obtained by the Physical Method, due to printing and measuring 
variations between the first and second prints. 

The VPR module in Curve4 Complete can test calculated curves without a 
second physical print. For the best accuracy, VPR requires a characterization 
target (e.g. IT8.7/4 or IT8.7/5) to be printed and measured at the same time as 
the P2P. 

Print the test target(s)  
Print at least one P2P51 target and an IT8.7/4 target, or an IT8.7/5 target. 

Note that to test a software’s ability to calibrate accurately, the printing system 
must produce successive prints that are consistent print-to-print and consistent 
across the whole image area. 

Ideally, all color management should be disabled and initial calibration curves 
should be “null” to produce a completely uncorrected print. 

Prints should be free from blemishes, streaks or other artifacts and have had 
sufficient time to dry or stabilize prior to measuring.  (See Curve4 User Guide 
for detailed target printing instructions.) 

Create a new Calibration 
In the Calibration panel, click New above the Calibrations list. 

In the Setup panel set the Method: to G7. 

In the Based On: list, select Linear (none). 

Measure the calibration target(s) 
In the Runs list. click on Run 1 - Calibration. 

Under the Measurements list, click the Measure button and follow instructions 
to measure the P2P or IT8.7/5 target(s). To automatically average more than 
one target, click Measure again and repeat the process. 

Measure the optional characterization target(s) 
If you printed a separate IT8.7/4 target, measure it into a separate Run. 

Adjust gray balance parameters 
In the Create Curves tab, click the Gray Balance Control tab and set the 
desired Gray correction feather-off: Start. For maximum accuracy on a stable 
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and repeatable printing system, set the Start to 98. For printing systems with 
unstable shadow characteristics, select a lower Start value, like 75 or 50. 

Other controls 
For system certification purposes, leave all other controls at their default 
settings. (For real-world production calibration, the Curve4 User Guide 
suggests when and how to adjust other controls.) 

Choosing Control Points 
In the Control Points list select the desired number and curve point values.  On 
real printing devices, fewer points are generally safer, but for maximum 
theoretical accuracy and/or system certification purposes, select 25-step (P2P). 

Export the measured data 
In the Measurements list, highlight the P2P (or IT8.7/5) measurement. 

In the File menu, select Export Measurement File... and save the 
measurement data with a suitable name. 

If you printed a separate IT8.7/4 target, export its data from its own Run. 

Use VPR to simulate a verification print sample 
Click the VPR tab. 

 
Figure 2: The VPR tab 
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In Target data to be curved:, select the same P2P or IT8.7/5 target data file 
used to create the curves. 

In Training Target (Optional):, if you calibrated from a P2P, select the 
characterization target file (e.g. IT8.7/4) printed with the P2P target. 

If you calibrated from an IT8.7/5, leave Training Target (Optional): empty. 

Under Curving Method: select Curve Lab values. 

Set the Precise / Smooth slider to Precise. 

Click Curve & Export… and save the data with “P2P_G7” in its name. 

Verifying G7 Grayscale Accuracy 

Load the “Verification” data 
Create a new Run. The default name will be Run 2 – Verification1. 

Under the Measurements list, click the + button and load the P2P_G7 file. 

Checking Pass/Fail status 
Click the Analyze tab. 

To test G7 Grayscale accuracy, any Reference can be selected, or select a G7 
Grayscale reference, if available (see Curve4 User Guide). 

 
Figure 1: The Analyze G7 Master tab 



          
 

 

 8 

If the wΔL* and wΔCh values under G7 Grayscale column are all green, your 
sample passes the current Idealliance G7 Master specifications. 

Curve4 Expected Performance 

Physical Method 
If working from actual printed samples, Curve4 should normally achieve 
accuracies substantially better than the G7 Master Pass/Fail tolerances. 
However note that results may occasionally be worse, or even fail G7 
Grayscale compliance, if the printing system suffers from unusually severe 
problems such as tone reversals, unevenness or mottling across the printing 
area, inconsistency between first and second prints, or if complex color 
management or ink limiting was active when the samples were printed. 

Modeling Method 
If using the VPR method to avoid a second print, Curve4 Complete should 
normally achieve accuracies substantially better than the Physical Method and 
better than the G7 Master Pass/Fail tolerances. However note that results may 
occasionally be worse, or even fail G7 Grayscale compliance, if the initial 
print(s) suffer from tone reversals, unevenness or mottling across the printing 
area, or if complex color management or ink limiting was active when the 
samples were printed. 

Official G7 System testing method 
If starting with the 2010 G7 System Certification sample test files instead of 
actual printed samples, and if using either the official G7 System Certification 
Testing method or the Modeling Method, Curve4 shall achieve tolerances 
much lower than the G7 System Certification tolerances shown here: 
 
Metric Average Maximum 
ΔCh (CMY only) <1.0 <2 
ΔL* (CMY & K) <1.0 <2 

Table 1: Curve4 predicted tolerances for 2010 sample test files 

Note:  Because the current G7 System Certification method uses a simulation 
process that eliminates print-to-print variation, and because the sample data 
files provided by Idealliance for G7 System Certification are highly uniform, 
Curve4 can produce extremely low delta errors with those specific data files.  
Higher errors should be expected when calibrating live printing devices, 
depending on the characteristics and variability of each printing system. 
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Idealliance G7 Grayscale Compliance Validation 
To validate G7 Grayscale compliance, a target containing two gray scales having the 
CMYK patch values listed in Appendix A: (i.e. columns 4 and 5 of the P2P51 target) 
must be printed and measured.  

Validating NPDC compliance (CMY and K scales) 

• The relative neutral density (ND) values (measured in the “K” or “Visual” 
channel) of each patch of both the K-only scale and CMY-only scales 
shall be measured and recorded. 

• To obtain relative ND values, either the measuring device shall be zeroed 
on the substrate, or the white patch neutral density value shall be 
subtracted from itself and all other patches. 

• The relative ND values shall be converted to relative L* by the standard 
CIE formula in Appendix B: and compared to target L* values determined 
by the NPDC formulae in ANSI CGATS: TR015. 

• The weighted delta L* (wΔL*) error shall be computed for each patch by 
the formula in Appendix B: 

• The average and maximum wΔL* must not exceed the Idealliance 
Tolerance values in Table 2, below, i.e. average 1.5, maximum 3.0. 

Validating Gray Balance compliance (CMY scale only) 

• The a* and b* values of each patch of the CMY-only scale shall be 
measured and recorded. 

• The weighted delta Ch (wΔCh) error shall be computed for each patch and 
compared to target values determined by the formula in Appendix B: 

• The average and maximum wΔCh must not exceed the Idealliance 
Tolerance values in Table 2, below, i.e. average 1.5, maximum 3.0. 

Idealliance G7 Grayscale Conformance Tolerances 
 

Metric Average Maximum 
wΔCh (CMY only) <1.5 <3 
wΔL* (CMY & K) <1.5 <3 

Table 2: Idealliance tolerances for G7 Grayscale Conformance
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Appendix A: 

 

P2P51 patch values 

Column 4 (K only) 
 

C% M% Y% K% 
0 0 0 0 
0 0 0 2 
0 0 0 4 
0 0 0 6 
0 0 0 8 
0 0 0 10 
0 0 0 15 
0 0 0 20 
0 0 0 25 
0 0 0 30 
0 0 0 35 
0 0 0 40 
0 0 0 45 
0 0 0 50 
0 0 0 55 
0 0 0 60 
0 0 0 65 
0 0 0 70 
0 0 0 75 
0 0 0 80 
0 0 0 85 
0 0 0 90 
0 0 0 95 
0 0 0 98 
0 0 0 100 

 Table 3: CMYK values in column 4 of the P2P51 target 
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P2P51 patch values 

Column 5 (CMY only) 
 

C% M% Y% K% 
0 0 0 0 
2 1.49 1.49 0 
4 2.98 2.98 0 
6 4.47 4.47 0 
8 5.97 5.97 0 
10 7.46 7.46 0 
15 11.21 11.21 0 
20 15.01 15.01 0 
25 18.88 18.88 0 
30 22.84 22.84 0 
35 26.9 26.9 0 
40 31.11 31.11 0 
45 35.46 35.46 0 
50 40 40 0 
55 44.74 44.74 0 
60 49.69 49.69 0 
65 54.9 54.9 0 
70 60.37 60.37 0 
75 66.12 66.12 0 
80 72.19 72.19 0 
85 78.59 78.59 0 
90 85.34 85.34 0 
95 92.47 92.47 0 
98 96.94 96.94 0 
100 100 100 0 

 Table 4: CMYK values in column 5 of the P2P51 target, rounded to 2 decimal places. 
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Appendix B: 

 

Formulae 

Converting ND to L* 

Calculating weighted delta L* (wΔL*) 

wΔL* = ΔL* x (1 – max(0, (% - 50)/50 x 0.75)) 
 

Calculating weighted delta Ch (wΔCh) (formerly wΔF*) 

wΔCh = ΔCh x (1 – max(0, (% - 50)/50 x 0.75)) 
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